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The information in this User’s Manual has been carefully reviewed and is believed to be accurate.  
The vendor assumes no responsibility for any inaccuracies that may be contained in this document, 
makes no commitment to update or to keep current the information in this manual, or to notify any 
person or organization of the updates.  Please Note:  For the most up-to-date version of 
this manual, please see our web site at www.supermicro.com.

SUPERMICRO COMPUTER reserves the right to make changes to the product described in this 
manual at any time and without notice.  This product, including software, if any, and documenta-
tion may not, in whole or in part, be copied, photocopied, reproduced, translated or reduced to any 
medium or machine without prior written consent.

IN NO EVENT WILL SUPERMICRO COMPUTER BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, SPECULATIVE OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE 
OR INABILITY TO USE THIS PRODUCT OR DOCUMENTATION, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.  IN PARTICULAR, THE VENDOR SHALL NOT HAVE 
LIABILITY FOR ANY HARDWARE, SOFTWARE, OR DATA STORED OR USED WITH THE 
PRODUCT, INCLUDING THE COSTS OF REPAIRING, REPLACING, INTEGRATING, INSTALLING 
OR RECOVERING SUCH HARDWARE, SOFTWARE, OR DATA.      
         
Any disputes arising between manufacturer and customer shall be governed by the laws of Santa 
Clara County in the State of California, USA.  The State of California, County of Santa Clara shall 
be the exclusive venue for the resolution of any such disputes.  Supermicro's total liability for all 
claims will not exceed the price paid for the hardware product.        

Manual Revision 1.0b

Release Date: October 17, 2007

Unless you request and receive written permission from SUPER MICRO COMPUTER, you may not 
copy or otherwise reproduce/distribute any part of this document.

Information in this document is subject to change without notice.  Other products and companies 
referred to herein are trademarks or registered trademarks of their respective companies or mark 
holders.

 
Copyright © 2007 by SUPER MICRO COMPUTER INC. 
All rights reserved. 
Printed in the United States of America
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Safety Information and Technical Specifications

Introduction

Overview

This manual is written for system integrators, PC technicians and knowledgeable 
PC users who intend to integrate SuperMicro's AOC-USAS-L4i and/or the AOC-
USAS-L4iR add-on cards to their system.

Product Features

The AOC-USAS-L4i and the AOC-USAS-L4iR add-on cards offer the following 
features:

• UIO Form Factor.

• Internal and External "ipass" cable ports.

• Multiple LED Activity/Failure indicators.

In addition, the AOC-USAS-L4iR add-on card offers:

• IR Mode and SWR with iButton

• RAID 5 with iButton

Operating Systems Supported

AOC-USAS-L4i and AOC-USAS-L4iR add-on cards support the following Operating 
Systems (OS):

• Windows 2000/Windows XP/Windows 2003

• Red Hat Enterprise Linux/SUSE Linux

An Important Note to Users

All images and layouts shown in this user's guide are based upon the latest PCB 
Revision available at the time of publishing. The card you have received may or 
may not look exactly the same as the graphics shown in this manual.
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 Contacting SuperMicro

Headquarters
Address: SuperMicro Computer, Inc.

980 Rock Ave.

San Jose, CA  95131 U.S.A.

Tel: +1 (408) 503-8000

Fax: +1 (408) 503-8008

Email: marketing@supermicro.com (General Information)

support@supermicro.com (Technical Support)

Web Site: www.supermicro.com

Europe
Address: SuperMicro Computer B.V.

Het Sterrenbeeld 28, 5215 ML 

's-Hertogenbosch, The Netherlands 

Tel: +31 (0) 73-6400390

Fax: +31 (0) 73-6416525

Email: sales@supermicro.nl (General Information)

support@supermicro.nl (Technical Support)

rma@supermicro.nl (Customer Support)

Asia-Pacific 
Address: SuperMicro, Taiwan

4F, No. 232-1, Liancheng Rd.

Chung-Ho 235, Taipei County

Taiwan, R.O.C. 

Tel: +886-(2) 8226-3990

Fax: +886-(2) 8226-3991

Web Site: www.supermicro.com.tw

Technical Support:

Email: support@supermicro.com.tw 

Tel:  886-2-8228-1366, ext.132 or 139
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Chapter 1  
 

Safety Guidelines

To avoid personal injury and property damage, carefully follow all the safety steps 
listed below when accessing your system or handling the components.

1-1 ESD Safety Guidelines

Electric Static Discharge (ESD) can damage electronic components.  To prevent dam-
age to your system, it is important to handle it very carefully.  The following measures 
are generally sufficient to protect your equipment from ESD.

• Use a grounded wrist strap designed to prevent static discharge.
• Touch a grounded metal object before removing a component from the anti-

static bag.
• Handle the RAID card by its edges only; do not touch its components, periph-

eral chips, memory modules or gold contacts.
• When handling chips or modules, avoid touching their pins.
• Put the card and peripherals back into their antistatic bags when not in use.

1-2 General Safety Guidelines

• Always disconnect power cables before installing or removing any components 
from the computer.

• Disconnect the power cable before installing or removing any cables from the 
system.

• Make sure that the add-on card is securely and properly installed on the moth-
erboard to prevent damage to the system due to power shortage.

1-3 An Important Note to Users

• All images and layouts shown in this user's guide are based upon the latest 
PCB Revision available at the time of publishing. The card you have received 
may or may not look exactly the same as the graphics shown in this manual.
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Notes
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Chapter 2  
 

LED Indicators and Connectors

2-1 Front Connectors and Jumpers

#1. Internal SAS Connector
#2. I-Button
#3. Front Panel LED Connector
#4. External SAS Connector

3

1

4

2
Buzzer

Front Connectors
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2-2 Front Connector and Pin Definitions

#3. Active LED Connector

Allows the add-on card to display activity 
and status using a standard LED panel.

#1.  Internal SAS Connector

The Internal SAS port (J3) connects to the 
backplane allowing the motherboard to 
access the hard drives and RAID capabili-
ties.  This connector supports up to 4 HDD 
ports.

Use a single port SAS "ipass" cable (Super 
Micro order number CBL - 0108L-02).

#2. iButton Socket

The iButton is used to enable RAID 5 with 
the AOC-USAS-L4iR card only.. To do this, 
you must install a SuperMicro ibutton and 
enable the SWR5 jumper. 

LED Connector 
Pin Definitions

(U-12)

Pin#     Definition     

1 A - LED+

2 A - LED-

3 B - LED+

4 B - LED-

#5.  External SAS Connector

The External SAS port (J4) allows the 
motherboard to connect to an external 
backplane.  This connector supports up to 
4 SAS drives.

Use a single port, external SAS cable (Su-
per Micro order number CBL - 0166L).
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2-3 Front Jumper Locations and Pin Definitions

Jumper Settings

Jumper Jumper Settings Note

SWR5 1-2: Enabled
3: Disabled

Enables or Disables Software Raid 5 
AOC-USAS-L4iR only.  Leave disabled 
for AOC-USAS-L4i

1
3

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

PC
B
ED

G
E

WWN

BAR CODE
1

3

AF

AE

AD

AC

AB

AA

Y
W

V

T

R

P

N

M

L

K
J

U

H

G

F

E

D

C
B

A

26
25

24
23

22
21

20
19

18
17

16
15

14
13

12
11

10987654321

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

A
C

A
C

SWR5 

Explanation of Jumpers

To modify the operation of the backplane, 
jumpers can be used to choose between 
optional settings.  Jumpers create shorts 
between two pins to change the function 
of the connector.  Pin 1 is identified with 
a square solder pad on the printed circuit 
board.  Note: On two pin jumpers, "Closed" 
means the jumper is on and "Open" means 
the jumper is off the pins. 

Connector
Pins

Jumper

Setting

3 2 1

3 2 1

Enabling RAID5

The SWR5 jumper is used to enable RAID 5 for the AOC-USAS-L4iR card only.
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Front Pane LEDs

LED STATE SPECIFICATION
LED1 Flashing SAS Port Activity

LED2 Flashing Heartbeat and Fault

LNP0 ON Fault in HHD #0

LNP1 ON Fault in HHD #1

LNP2 ON Fault in HHD #2

LNP3 ON Fault in HHD #3

LNP4 ON Fault in HHD #4

LNP5 ON Fault in HHD #5

LNP6 ON Fault in HHD #6

LNP7 ON Fault in HHD #7

A0 Flashing Normal Activity in HHD #0

A1 Flashing Normal Activity in HHD #1

A2 Flashing Normal Activity in HHD #2

A3 Flashing Normal Activity in HHD #3

A4 Flashing Normal Activity in HHD #4

A5 Flashing Normal Activity in HHD #5

A6 Flashing Normal Activity in HHD #6

A7 Flashing Normal Activity in HHD #7

LED INDICATORS

1
3

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

PC
B
ED

G
E

WWN

BAR CODE

1
3

AF

AE

AD

AC

AB

AA

Y
W

V

T

R

P

N

M

L

K
J

U

H

G

F

E

D

C
B

A

26
25

24
23

22
21

20
19

18
17

16
15

14
13

12
11

10987654321

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

A
C

A
C

1
3

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

PC
B
ED

G
E

WWN

BAR CODE

1
3

AF

AE

AD

AC

AB

AA

Y
W

V

T

R

P

N

M

L

K
J

U

H

G

F

E

D

C
B

A

26
25

24
23

22
21

20
19

18
17

16
15

14
13

12
11

10987654321

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

A
C

A
C

POWER LEDS
LNP0 - LNP7

A0 - A7

1
3

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

PC
B
ED

G
E

WWN

BAR CODE

1
3

AF

AE

AD

AC

AB

AA

Y
W

V

T

R

P

N

M

L

K
J

U

H

G

F

E

D

C
B

A

26
25

24
23

22
21

20
19

18
17

16
15

14
13

12
11

10987654321

1
4

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

A
C

PC
BE

DG
E

A
C

A
C

 LED1

LED2



2-5

Safety Information and Technical Specifications

RAID Minimum Drive Requirements

RAID Minimum Hard Drives
RAID 0 2
RAID 1 2
RAID 5* 3*
RAID 10 4 (2 RAID 1 Arrays) 

Use the following chart to determine the minimum number of hard drives needed 
to set up a RAID environment.

* Raid 5 is supported by the AOC-USAS-L4iR add-on card.
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Notes
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Chapter 3  
 

Driver Installation

The MegaRAID BIOS Configuration Utility (CU) is used to configure disk arrays and 
logical drives and to do other configuration tasks in a pre-bootenvironment.

3-1 Performing a Quick Configuration

This section provides high level instructions for quickly configuring arrays and logical 
drives with the MegaRAID BIOS CU. These instructions are intended for users that 
are familiar with configuration utilities and tools.  Refer to Section 3-2, “Configuring 
Arrays and Logical Drives,” for detailed configuration instructions. To ensure the best 
performance, select the optimal RAID level for the logical drive you create.

Important: It is recommended that you do not use both SAS and SATA drives in the 
same array. Using different drive interfaces in this way could cause unpredictable be-
havior, decreased performance, an increased error count, and decreased MTBF.

Perform the following steps to configure arrays and logical drives using the Mega-
RAID BIOS CU:

1. Boot the system.

2. Start the MegaRAID BIOS CU by pressing Ctrl+H.

3. Select Configure from the Management Menu.

4. Select a configuration method from the Configuration menu (Easy Configuration, 
New Configuration, or View/Add Configuration).

5. Create arrays using the available physical drives.

6. Define the logical drive(s) using the space in the arrays.

7. Initialize the new logical drive(s).
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3-2 Configuring Arrays and Logic Drives 

This section provides detailed instructions for configuring arrays and logical drives 
with the MegaRAID BIOS CU. LSI recommends that you use drives with the same 
capacity when you create a storage configuration. If you use drives with different 
capacities in one array, the CU limits each drive to the capacity of the smallest 
drive.

The number of physical drives in a specific array determines the possible RAID 
levels that you can implement with the array.

• RAID 0 requires from one to eight physical drives.

• RAID 1 requires two physical drives.

• RAID 5 requires three physical drives.

• RAID 10 requires four, six, or eight physical drives.

Starting the MegaRAID BIOS CU

Follow these steps to start the MegaRAID BIOS CU:

1. During boot-up, wait for the following message to appear on the screen:

Press Ctrl-H to run LSI Logic Software RAID Setup Utility

2. When you see this message, hold down the Ctrl key while pressing the H key. 
The main menu for the Configuration Utility appears, as shown in Figure 3-1. 

Figure 3-1: Configuration of the Main Utility
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Note: When you start the MegaRAID BIOS CU by pressing Ctrl-H the Configuration 
Manager Module of the BIOS allocates three segments of memory using either PMM 
or conventional memory: these are the Destination Segment, Scratch Segment, and 
Read Write Buffer Segment. If the three segments are not available the BIOS hooks 
INT19h and loads the CU at the fixed segments 5000:0 (Destination Segment), 
6000:0 (Scratch Segment) and 7000:0 (Read Write Buffer Segment) after POST.

Using Easy Configuration

When you select the Easy Configuration option, the CU creates one or more arrays 
from the available physical drives and configures each array as a single logical drive. 
If logical drives have already been configured, the CU does not change their con-
figuration. Follow these steps to create a logical drive using Easy Configuration:

1. Select Configuration→ Easy Configuration from the Management Menu. A list of 
available (READY) physical drives appears.

2. Use the arrow keys to select the physical drives to include in the array.

3. Press the spacebar to add each selected physical drive to the new array.

When you select a physical drive, its status changes from READY to ONLIN 
A[array number]-[drive number]. For example, ONLIN A00-01 means array 0, 
disk drive 1.

4. To create a global hotspare drive, highlight a READY disk drive and press F4. 
Then select Yes from the pop-up menu.

5. To define multiple arrays, select all the drives you want for the first array, then 
press Enter to start selecting drives for the second array, and so on.

6. When you have selected drives for all desired arrays, press F10.

7. Press the spacebar to select an array.

The Logical Drive Configuration screen appears, as shown in Figure 3-2. This 
screen shows the logical drive number, RAID level, logical drive size, number of 
stripes in the physical array, stripe size, and state of the logical drive.
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Figure 3-2: Logical Drive Configuration

8. Highlight RAID and press Enter.

The available RAID levels for the current logical drive are displayed.

9. Select a RAID level for the logical drive and press Enter.

10. (Optional) Change the drive’s default Write Cache and Read Ahead policies (see 
Section 3-3, “Setting the Hard Disk Write Cache and Read Ahead Policies”).

11. When you have finished defining the current logical drive, select Accept and 
press Enter.

12. Save the configuration when prompted, and press any key to return to the 
Management Menu.

13. Initialize the new logical drive(s). (See Section 3 “Initializing Logical Drives,” for 
detailed instructions.)

Using New Configuration and View/Add Configuration

When you select the New Configuration menu option, the CU deletes the existing 
arrays and logical drives and replaces them with the new configuration that you 
specify. The View/Add Configuration menu option lets you view the existing con-
figuration or add to the existing configuration, if possible.

Caution: If you want to keep the existing data on the storage configuration, use 
View/Add Configuration instead of New Configuration.
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Follow these steps to configure a disk array using the New Configuration or View/
Add Configuration option:

1. Select Configuration→ New Configuration or Configuration→ View/Add Configu-
ration from the Management Menu. If you selected New Configuration, select Yes 
to proceed. (This confirms that you are erasing the existing storage configuration.) 
The CU displays an array selection window. 

Note: The existing storage configuration will be erased only if you save the newly 
created configuration at the end of the process. It you do not save the new con-
figuration, the CU will restore the previously existing configuration.

2. Use the arrow keys to select physical drives for the new array.

3. Press the spacebar to add each selected physical drive to the new array.

When you select a drive, its status changes from READY to ONLIN A[array num-
ber]-[drive number]. For example, ONLIN A00-01 means array 0, disk drive 1.

4. To create a global hotspare drive, highlight a READY disk drive and press F4. 
Then select Yes from the pop-up menu.

Make sure the capacity of the hotspare drive is equal to or larger than the capacity 
of the disks in the array and that it is the same type of drive (SAS or SATA).

Note: The hotspare drive will rebuild a failed drive even if it is SAS and the failed 
drive is SATA, or vice versa. Once the rebuilt is completed, however, LSI recom-
mends that you replace the new array member with a drive of the same type.

5. To define multiple arrays, select all the drives you want for the first array, then 
press Enter to start selecting drives for the second array, and so on.

6. When you have selected drives for all desired arrays, press F10.

7. Press the spacebar to select an array, if needed.

8. Highlight RAID and press Enter.

A list of the available RAID levels for the current logical drive appears.
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9. Select a RAID level for the logical drive and press Enter.

10. (Optional) Set the logical drive size by highlighting Size and Enter.

The minimum valid logical drive size is 64 Mbytes. An error will appear if you try 
to create a logical drive that is smaller 64 Mbytes. By default, all the available 
space in the array is to the current logical drive. For RAID 10 arrays, only one 
logical can be defined for the entire array.

11. (Optional) Change the disks’s default Write Cache and Read policies (see Sec-
tion 3-3, “Setting the Hard Disk Write Cache Read Ahead Policies”).

12. When you have finished defining the current logical drive, Accept and press 
Enter.

13. Configure additional logical drives on the same array, if desired. you have cre-
ated more than one array, configure a logical the second array.

14. Save the configuration when prompted, and press any key to the Management 
Menu.

15. Initialize the new logical drive(s). (See Section 3-2 “Initializing Logical Drives,” 
for detailed instructions.)

Creating a Global Hotspare Drive

The MegaRAID BIOS CU enables you to create global hotspare drives (dedicated 
hotspare drives are not supported). A hotspare drive can automatically replace a 
failed drive in a redundant RAID 1 or RAID 10 array, to protect against data loss.

Important: When you select disk drive for a global hotspare, be sure it is the 
same type of drive (either SAS or SATA) as the drives in the arrays that it will 
protect. LSI recommends that you do not combine SAS and SATA drives in the 
same array.

You can create a hotspare when you are configuring a new storage configuration, as 
described in the previous sections. To add a hotspare drive to an existing redundant 
storage configuration, follow these steps: 

1. Select Objects from the Management Menu.

2. Select Physical Drive. A list of physical drives appears.
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3. Select an unconfigured drive or Ready drive from the list, and press Enter.

4. When the Physical Drive Property menu appears, select Make Hot Spare and 
press Enter.

5. Select Yes from the pop-up menu to create the hotspare drive.

Note: To remove a hotspare drive, perform steps 1 and 2 above, select the 
HOTSP disk, press Enter, select Force Offline, and press Enter. The status of the 
drive changes to READY, and it can then be used in another new array.

Initializing Logical Drives

Caution: When you initialize a logical drive all existing data on the logical drive 
is erased.

This section explains the two methods of initializing a logical drive with the Mega-
RAID BIOS CU. If the Fast Init property is enabled, fast initialization will be used. 
In fast initialization, the MegaRAID BIOS CU quickly writes zeroes to the first and 
last 8 Mbyte regions of the new logical drive. If the Fast Init property is not enabled, 
the MegaRAID BIOS CU performs a complete initialization on the logical drive. This 
may take a long time if the physical disk drives are large.

(First Initialization Method) Follow these steps to initialize a logical drive using the 
Initialize menu:

1. On the Management Menu, select Initialize.

2. Use the spacebar to highlight the logical drive to initialize. The logical drive name 
is highlighted in yellow. To deselect it, highlight the logical drive and press the 
spacebar again.

3. Press F10.

4. Select Yes at the prompt and press Enter to begin the initialization.

A graph shows the progress of the initialization until it is complete.



3-8

   Add-on Card User's Guide

5. After the initialization is complete, press Esc to return to previous menus.

If you press Esc while initialization is in progress, the following options appear: 
– Stop: (Available only if AutoResume is enabled on the adapter: Management 
Menu→ Objects→ Adapter→ AutoResume.) The initialization is stopped, and the 
CU stores the percentage of the initialization already completed. If AutoResume is 
enabled, and if Fast Init is not enabled, the initialization resumes where it left off 
when you restart it, instead of starting over from 0 percent.

– Continue: The initialization continues normally.

– Abort: The initialization is completely aborted. If you restart initialization, it begins 
at 0 percent.

(Second Initialization Method) Follow these steps to initialize a logical drive using 
the Objects menu.

1. From the Management Menu, select Objects→ Logical Drive, as shown in Figure 
3-3.

A list of configured logical drives appears.

Figure 3-3: Logical Drive Submenu

2. Select a logical drive, if there is more than one configured, and press Enter.

3. Select Initialize from the submenu and press Enter.
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4. Select Yes at the prompt and press Enter.

The CU displays a bar graph showing the initialization progress.

5. When initialization completes, press Esc to return to the previous menu. 

If you press Esc while initialization is in progress, the Stop, Continue, and Abort 
options are available, as explained earlier in this section.

3-3 Setting the Hard Disk Write Cache and Read Ahead 
Policies

You can use the MegaRAID BIOS CU to set the hard disk drive Write Cache and 
Read Ahead settings. Any read or write cache policy changes apply to all logical 
drives on an array. In other words, if two logical drives are defined on a single array 
and you change the Read Ahead setting on one logical drive, the change will also 
apply to the other logical drive on the array.

The Disk Write Cache and Read Ahead policies can be set to On or Off.

• When the disk Write Cache is On, a write transaction is considered to be complete 
when all the data has been written to the disk cache. When disk Write Cache 
is Off, the write transaction is complete only when the data has been written to 
the disk. 

• When disk Read Ahead is On, extra data is read sequentially ahead of the data 
that is actually requested and is stored in a cache. If the additional read-ahead 
data is then requested, it can be read faster from the cache than from the disk 
directly. 

Note: When the disk Write Cache is On, there is a danger that data could be lost 
if the power fails before the cached data is written to disk.

Follow these steps to view or change the logical drive Write Cache or Read 
Ahead settings: 

1. From the Management Menu, select Objects→ Logical Drive→Logical Drive n→ 
View/Update Parameters.

2. Use the arrow key to move the cursor to Disk WC or Read Ahead and press 
Enter.
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3. Use the arrow key to select Off or On for Disk WC (DWC) or Read Ahead.

4. When you see the prompt Change DWC or Change Read Ahead, use the arrow 
key to select Off or On, then press Enter to change the cache setting.

The settings are changed for all logical drives defined on the array.

3-4 Rebuilding a Drive

The MegaRAID BIOS CU enables you to rebuild a drive of a redundant array if the 
array has a failed drive. If the failed drive is still good (that is, if the drive is physi-
cally present and its size is greater than or equal to the defined size of the array) it 
will be rebuilt. If the drive is small, an error message will appear and the MegaRAID 
BIOS CU will not allow the drive to be rebuilt. A rebuild cannot be started on a failed 
drive if its size is even 1 byte smaller than the defined size of the array. 

Follow these steps to rebuild a drive:

1. Select Rebuild from the Management Menu.

2. When the list of drives appears, highlight the FAIL drive that you want to rebuild 
and press the Spacebar to select it.

3. After selecting the physical drive, press F10 and select Yes at the confirmation 
prompt.

The rebuild process begins, and a graph shows the progress of the rebuild until it 
is complete. Although the CU changes the disk drive state to Rebuild at this point, 
the change does not appear on the screen while the rebuild is in progress. If the 
CU detects a media error on the source drive during rebuild, it initiates a sector 
read for that block. If the sector read fails, the CU adds entries to the Soft Bad 
Block Management (SBBM) table, writes this table to the target drive, and displays 
an error message. Additional error messages are displayed if the SBBM table is 
80% full or 100% full. If the SBBM table is completely full, the rebuild operation is 
aborted, and the drive is marked as FAIL.
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4. When rebuild is complete, the CU displays the message:

Rebuilding of Drive X Completed Successfully. Press Esc. (X = the ID of the 
rebuilt drive.)

5. Press Esc to display the Management Menu.

The state of the rebuilt disk drive changes from FAIL to ONLIN.

If you press Esc while the rebuild is running, the following options display:

•  Stop: (Available only if AutoResume is enabled on the adapter: Management 
Menu -> Objects -> Adapter -> AutoResume.) The rebuild is stopped, and the 
CU stores the percentage of the rebuild already completed. If AutoResume is 
enabled, the rebuild resumes where it left off when you restart it, instead of start-
ing over from 0 percent. 

•  Continue: The rebuild continues normally.

•  Abort: The rebuild is completely aborted and the disk drive remains in the FAIL 
state. If you restart the rebuild, it begins at 0 percent.

3-5 Hot Plug Support

The MegaRAID BIOS CU supports hot plugging of disk drives. The following hot 
plug message will appear when you insert or remove a disk drive: A Drive Has 
Been Inserted/Removed. Configuration Updated. Press ESC... After you press Esc 
the inserted or removed drive will be reflected in the list of drives that appears in 
the configuration utility.

You should not insert or remove a drive while you are defining a new logical drive 
or while an initialization or other process is running. The following bullets describe 
how the CU handles hot plugging when various actions occur:

•  If the Physical Drive window or one of the Configuration windows is open when 
you insert or remove a drive, the window will close when the hot plug message 
appears.
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• CU menus such as Select Boot Drive, Select Adapter, and Logical Drive menus 
will completely or partially close when a drive is inserted or removed.

• If a Rebuild is in progress when you insert or remove a drive, the CU will first 
display the message Rebuilding Of Drive Not Complete! Press Esc.. followed by 
the hot plug message. If the Rebuild was not affected by this hot plug event, it will 
continue to rebuild from where it left off, provided that Auto Resume is enabled; 
otherwise, Rebuild will start over from the beginning. If the rebuilding array was 
affected by the hot plug event, the Rebuild will abort and the array status will 
change based on the hot plug operation.

• If an Initialization is in progress when you insert or remove a drive, the CU will 
display the message Initialization of Array Not Complete! Press ESC.. followed 
by the hot plug message.

• If a consistency check is in progress when you insert or remove a drive, the CU 
will display the message CC Not Completed! Press ESC.. followed by the hot 
plug message.

3-6 Checking Data Consistency

The Check Consistency feature can be used on RAID 1 or RAID 10 logical drives 
to verify the data consistency between the mirrored physical drives. The MegaRAID 
BIOS CU automatically corrects any differences found in the data when a consis-
tency check is run. Follow these steps to check consistency:

1. On the Management Menu select Check Consistency and press Enter.

A list of configured logical drives is displayed.

2. Highlight a logical drive with the arrow keys.

3. Press the spacebar to select the logical drive to check for consistency.

Note: If you select a RAID 0 logical drive, a message appears stating that a 
Check Consistency cannot be performed. To continue, deselect the logical drive, 
highlight a redundant logical drive, and press the spacebar again.
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4. Press F10.

5. At the prompt, select Yes to start the Check Consistency process and press 
Enter. A graph shows the progress of the Check Consistency operation until it is 
complete.

If the MegaRAID BIOS CU finds any data inconsistencies while comparing the 
source and target drives, it fixes the inconsistency by writing the source data to 
the target drive. When this happens, the following message appears at the bottom 
of the screen:

The Data on the Drives is inconsistent. Repair done!

If the MegaRAID BIOS CU finds a media error on the source drive, it pops up a 
dialog box with this message:

Error in Reading Sectors! Proceed Anyway (Y/N)?

If you press Y, the program skips the bad block and continues. If you press N, the 
program aborts the consistency check. The same message appears if the program 
finds a hard media error on the target drive.

If you press Esc while a Check Consistency is running, the following options are 
displayed:

• Stop: (Available only if AutoResume is enabled on the adapter: Management 
Menu→ Objects→ Adapter→ AutoResume.) The Check Consistency is stopped, 
and the CU stores the percentage of the task already completed. If AutoResume 
is enabled, the Check Consistency resumes where it left off when you restart it, 
instead of starting over from 0 percent.

• Continue: The Check Consistency continues normally.

• Abort: The Check Consistency is completely aborted. If you restart it, it begins 
at 0 percent.

3-7 Viewing and Changing Device Properties

The MegaRAID BIOS CU allows you to view properties for adapters, logical drives, 
and physical drives. You can also change some properties for adapters and logical 
drives. 
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Viewing and Changing Adapter Properties

To view or change adapter properties, follow these steps:

1. On the Management Menu, select Objects→ Adapter.

2. Select an adapter from the list. The following list of adapter properties appears:

1. The Disk coercion property can be accessed only when no configuration is pres-
ent for the adapter.  Otherwise, an error message will appear.

3. If you want to change the value of a property, highlight it and press Enter.

4. Select or type a different value for the property and press Enter.

5. When you are finished, press Esc until you return to the Management Menu.
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Viewing and Changing Logical Drive Properties

To view or change logical drive properties, follow these steps:

1. On the Management Menu, select Objects → Logical Drive.

2. Select View/Update Parameters.

The only logical drive properties you can change are Disk WC (Disk Write Cache) 
and Read Ahead (see Section 3-3, “Setting the Hard Disk Write Cache and Read 
Ahead Policies”). The other properties are view-only.

Viewing Physical Drive Properties

To view physical drive properties, follow these steps:

1. On the Management Menu, select Objects → Physical Drive.

2. Highlight a physical drive on the list that appears and press Enter.

3. Select Drive Properties from the menu.

The drive properties are Device Type (Disk), Capacity, Product ID, and Revision 
No. These properties are view-only.

3-8 Forcing Drives Online or Offline

The MegaRAID BIOS CU enables you to force drives online or offline. You may want 
to force a drive of a redundant array offline so that a hotspare drive will automati-
cally replace it. An auto rebuild will begin immediately if the MegaRAID BIOS CU 
finds a valid hotspare drive to replace the offline drive.

You may need to force a drive online if it has gone offline due to a power failure. The 
MegaRAID BIOS CU will not allow a drive to be forced online if its size is smaller 
than the defined size of the array.

To force a drive online or offline, follow these steps:

1. On the Management Menu, select Objects → Physical Drive.

2. Highlight a physical drive that is a member of an array and press Enter.

3. Select Force Offline or Force Online from the menu.

If the drive was online, its status changes to FAIL. If it was offline, its status changes 
to ONLIN.
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3-9 Configuring a Bootable Logical Drive

The default boot logical drive is LD 0. If you change the boot drive to another logi-
cal drive, the BIOS and the CU will preserve this change. However, if you delete 
the new boot logical drive, you must be sure to configure another logical drive for 
booting. The MegaRAID BIOS CU will not automatically select a different boot 
logical drive.

Follow these steps to configure a bootable logical drive:

1. On the Management Menu, select Configure -> Select Boot Drive.

2. Select a logical drive from the list to be the designated boot drive.

3-10 Deleting a Logical Drive

Caution: Before you delete a logical drive, be sure to back up all the data you 
want to keep.

The MegaRAID BIOS CU allows you to delete any single logical drive defined in 
the configuration (sometimes referred to as random deletion).

To delete a specified logical drive, follow these steps:

1. Select Objects -> Logical Drive.

2. Highlight the logical drive that you want to delete and press Delete.

3. Select Yes when the confirmation message appears.

3-11 Clearing a Storage Configuration

Caution: Before you clear a storage configuration, be sure to back up all the data 
you want to keep.

To clear a storage configuration, follow these steps:

1. On the Management Menu, select Configure → Clear Configuration.

2. When the message appears, select Yes to confirm. 

All logical drives are deleted from the configuration.
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Chapter 4

MegaRAID Storage Manager Software 
Overview and Installation

MegaRAID Storage Manager software is a configuration and monitoring utility used 
with the Embedded MegaRAID Software. This chapter provides a brief overview 
of the MegaRAID Storage Manager software and explains how to install it on the 
supported operating systems.

4-1 Overview

MegaRAID Storage Manager software enables you to configure, monitor, and 
maintain storage configurations created under Embedded MegaRAID Software. 
The MegaRAID Storage Manager graphical user interface (GUI) makes it easy for 
you to create and manage storage configurations.

Note: MegaRAID Storage Manager software can be used to manage a wide range 
of MegaRAID controllers. Some MegaRAID Storage Manager software features are 
not applicable for Embedded MegaRAID Software.

Creating Storage Configurations

MegaRAID Storage Manager software enables you to easily configure the control-
lers, disk drives, and virtual disks on your workstation or server. The Configuration 
Wizard greatly simplifies the process of creating arrays and virtual disks.



4-2

   Add-on Card User's Guide

You can use the Configuration Wizard Auto Configuration mode to automatically 
create the best possible configuration with the available hardware. You can use the 
Guided Configuration mode, which asks you a few brief questions about the configu-
ration, and then creates it for you. Or you can use the Manual Configuration mode, 
which gives you complete control over all aspects of the storage configuration.

Monitoring Storage Devices

MegaRAID Storage Manager software displays the status of virtual disks, physical 
disks, and other storage devices on the workstation or server that you are monitor-
ing. System errors and events are recorded in an event log file and are displayed on 
the screen. Special device icons appear on the screen to notify you of disk failures 
and other events that require immediate attention.

Maintaining Storage Configurations

You can use MegaRAID Storage Manager software to perform system maintenance 
tasks such as running consistency checks on arrays that support redundancy.

4-2 Hardware and Software Requirements

The hardware requirements for MegaRAID Storage Manager software are as fol-
lows:

• PC-compatible computer with an IA-32 (32-bit) Intel Architecture processor or an 
EM64T (64-bit) processor and at least 128 Mbytes of system memory (256 Mbytes 
recommended)

• Hard disk drive with at least 50 Mbytes available free space

The supported operating systems for the MegaRAID Storage Manager software 
are as follows:

• Microsoft Windows 2000, Microsoft Windows Server 2003, and Microsoft Windows 
XP.

• Red Hat Linux 3.0 or 4.0

• SUSE SLES 9, with latest updates and service packs

Refer to your server documentation and to the operating system documentation for 
more information on hardware and operating system requirements.
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4-3 Installation

This section explains how to install (or reinstall) MegaRAID Storage Manager soft-
ware on your workstation or server for the supported operating systems: Microsoft 
Windows, Red Hat Linux, and SUSE Linux. 5.3.1 Installing MegaRAID Storage 
Manager Software on Microsoft Windows

Follow these steps if you need to install MegaRAID Storage Manager software on 
a system running Microsoft Windows 2000, Microsoft Windows Server 2003, or 
Microsoft Windows XP:

1. Insert the MegaRAID Storage Manager software installation CD in the CD-ROM 
drive. If necessary, find and double-click the setup.exe file to start the installation 
program.

2. When the Welcome screen appears, click Next. If MegaRAID Storage Manager 
software is already installed on this system, the Program Maintenance screen ap-
pears. Read the screen text and select Modify, Repair, or Remove.

3. When the next screen appears, read and accept the user license, and click Next. 
The Customer Information screen appears, as shown in Figure 5.1.
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4. Enter your user name and organization name. In the bottom part of the screen, 
select an installation option:

– If you select All users, any user with administrative privileges can use this version 
of MegaRAID Storage Manager software to view or change storage configura-
tions.

– If you select Only for current user, the MegaRAID Storage Manager shortcuts and 
associated icons will be available only to the user with this user name.

5. Click Next to continue. 

6. On the next screen, accept the default Destination Folder, or click Change to 
select a different destination folder. Click Next to continue.

The Setup Type screen appears, as shown in Figure 4.2.

Figure 4.1: Customer Information Screen
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Figure 4.2: Customer Information Screen
7. Select one of the Setup options. The options are fully explained in the screen 
text.

– Normally, you would select Complete if you are installing MegaRAID Storage 
Manager software on a server. 

– Select Client if you are installing MegaRAID Storage Manager software on a PC 
that will be used to view and configure servers over a network.

– Select Server to install only those components required for remote server man-
agement.

– Select StandAlone if you will use MegaRAID Storage Manager software to create 
and manage storage configurations on a standalone workstation.

8. Click Next to proceed.

9. Click Install to install the program.

10. Click Finish when the final Configuration Wizard screen appears.
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If you select Client installation for a PC used to monitor servers, and if there are no 
available servers with a registered framework on the local subnet (that is, servers 
with a complete installation of MegaRAID Storage Manager software), you cannot 
connect to a remote server unless you first edit the startupui.bat file. Specifically, you 
must add the IP address of the remote server to the end of the startupui.bat file.

For example, to connect to a remote framework on server 192.168.0.10, add the IP 
address to the end of startupui.bat as shown in this example: start JRE\bin\javaw 
-classpath .;GUI.jar GUI.VivaldiStartupDialog ajsgyqkj=71244 192.168.0.10

Be sure to include a space in front of the IP address, as shown in the example.

Installing MegaRAID Storage Manager Software for Linux

Follow these steps if you need to install MegaRAID Storage Manager software on 
a system running Red Hat Linux or SUSE Linux:

1. Copy the SSM_linux_installer...tar.gz file to a temporary folder.

2. Untar the SSM_linux_installer...tar.gz file using the following command:

tar -zxvf SSM_linux_installer...tar.gz A new disk directory is created.

3. Go to the new disk directory.

4. In the disk directory, find and read the readme.txt file.

5. To start the installation, enter the following command:

./install.sh

If you select Client installation for a PC used to monitor servers, and if there are no 
available servers with a registered framework on the local subnet (that is, servers 
with a complete installation of MegaRAID Storage Manager software), you cannot 
connect to a remote server unless you first edit the startupui.sh file. Specifically, you 
must add the IP address of the remote server to the end of the startupui.sh file.

For example, to connect to a remote framework on server 192.168.0.10, add the 
IP address to startupui.sh as shown in this example: 

start JRE\bin\javaw -classpath .;GUI.jar GUI.VivaldiStartupDialog ajsgyqkj=71244 
192.168.0.10

Be sure to include a space in front of the IP address, as shown in the example.
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Linux Error Messages

One or more of the following messages may appear while you are installing Mega-
RAID Storage Manager software on a Linux system:

• More than one copy of MegaRAID Storage Manager software has been in-
stalled.

This message indicates that the user has installed more than one copy of MegaRAID 
Storage Manager software. (This can be done by using the rpm-force command to 
install the rpm file directly, which is not recommended, instead of using the install.sh 
file.) In such cases, the user must uninstall all the rpm files manually before installing 
MegaRAID Storage Manager software with the procedure listed previously.

• The version is already installed.

This message indicates that the version of MegaRAID Storage

Manager software you are trying to install is already installed on the

system.

• The installed version is newer.

This message indicates that a version of MegaRAID Storage

Manager software is already installed on the system, and it is a

newer version than the version you are trying to install.

• Exiting installation.

This is the message that appears when the installation is complete.

• RPM installation failed.

This message indicates that the installation failed for some reason.

Additional message text explains the cause of the failure.
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Notes
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Chapter 5

MegaRAID Storage Manager 
Window and Menus

This chapter explains how to start MegaRAID Storage Manager software and de-
scribes the MegaRAID Storage Manager window and menus.

5-1 Starting MegaRAID Storage Manager Software

Follow these steps to start MegaRAID Storage Manager software and view the 
main window:

1. Start the program using the method required for your operating system environ-
ment:

– To start MegaRAID Storage Manager software on a Microsoft Windows system, 
select Start -> Programs -> MegaRAID Storage Manager -> StartupUI, or double-
click the MegaRAID Storage Manager shortcut on the desktop.

Note: If a warning appears stating that Windows Firewall has blocked some fea-
tures of the program, click Unblock to allow MegaRAID Storage Manager software 
to start. (The Windows Firewall sometimes blocks the operation of programs that 
use Java.)

– To start MegaRAID Storage Manager software on a Red Hat Linux system, select 
Applications -> System Tools -> MegaRAID Storage Manager StartupUI.

– To start MegaRAID Storage Manager software on a SUSE SLES 9 system, select 
Start -> System -> More Programs -> MegaRAID Storage Manager.

When the program starts, the Select Server window appears, as shown in Figure 
5-1.
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Figure 5-1: Select Server Window

If the circle in the server icon is yellow instead of green, it means that the server is 
running in a degraded state—for example, because a disk drive used in a virtual disk 
has failed. If the circle is red, the storage configuration in the server has failed.

Note: To access servers on a different subnet, type in the box at the bottom of the 
screen the IP address of a server in the desired subnet where MegaRAID Storage 
Manager software is running, and click Update. If you check the Connect to remote 
Framework box, you can also access a standalone installation of MegaRAID Stor-
age Manager software, if it has a network connection.

2. Double-click the icon of the server that you want to access. The Server Login 
window appears, as shown in Figure 6.2.
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Figure 5-2: Select Server Window

3. Select an access mode from the drop-down menu.

– Select Full Access if you need to both view the current configuration and change 
the configuration.

– Select View Only if you need to only view and monitor the configuration.

4. Enter your user name and password, and click Login.

Note: If the computer is networked, this is the login to the computer itself, not the 
network login.

You must enter the root/administrator user name and password to use Full Access 
mode. If your user name and password are correct for the Login mode you have 
chosen, the main MegaRAID Storage Manager window appears.
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5-2 MegaRAID Storage Manager Window

This section describes the MegaRAID Storage Manager window, which is shown 
in Figure 5-3.

The following topics describe the panels and menu options that appear in this 
window.
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Physical/Logical View Panel

The left panel of the MegaRAID Storage Manager window displays either the 
Physical view or the Logical view of the system and the devices in it, depending 
on which tab is selected.

•  The Physical view shows the hierarchy of physical devices in the system. At the 
top of the hierarchy is the system itself. One or more controllers are installed in 
the system. Each controller has one or more ports. Disk drives and other devices 
are attached to the ports.

•  The Logical view shows the hierarchy of controllers, virtual disks, and disk groups 
that are defined on the system. (Physical drives also appear in the Logical view, 
so you can see which physical drives are used by each virtual disk.)

The following icons in the left panel represent the controllers, disk drives, and other 
devices:

• System

• Controller

• Port

• Array

• Virtual disk

• Physical drive

A red circle to the right of an icon indicates that the device has failed. 

A yellow circle to the right of an icon indicates that a device is running in a de-
graded state. 
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Properties/Operations/Graphical View Panel

The right panel of the MegaRAID Storage Manager window has either two or three 
tabs, depending on what kind of device is selected in the left panel.

• The Properties tab displays information about the selected device. For example, 
if a controller icon is selected in the left panel, the Properties tab lists information 
such as the controller name and the device port count.

• The Operations tab lists the operations that can be performed on the device that 
is selected in the left panel. Some types of devices, such as arrays and ports, do 
not have operations associated with them.

• The Graphical View tab can be selected in the right panel if a physical drive or 
virtual disk is selected in the left panel. In graphical view, the device’s storage ca-
pacity is color coded according to the legend shown on the screen. For example, 
on a physical drive configured space is blue, available space is white, and reserved 
space is red.

Event Log Panel

The lower part of the MegaRAID Storage Manager window displays the system 
event log entries, as shown in Figure 5-3. New event log entries appear during the 
session. Each entry has a timestamp and date, an error level indicating the severity 
of the event, and a brief description of the event. 
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Menu Bar

Here are brief descriptions of the main selections on the MegaRAID Storage Man-
ager menu bar. 

File Menu

The File menu has an Exit option for exiting from the MegaRAID Storage Manager 
software. It also has a Rescan option for updating the display in the MegaRAID 
Storage Manager window. (Rescan is seldom required; the display normally updates 
automatically.)

Operations Menu

The Operations menu is available when a controller, physical drive, or logical drive is 
selected in the MegaRAID Storage Manager window. The Operations menu options 
vary depending on what type of device is selected in the left panel of the MegaRAID 
Storage Manager window. The options also vary depending on the current state of 
the selected device. For example, if you select an offline physical drive, the Make 
Drive Online option appears in the Operations menu.

You can also view the Operations selections on the main window on the Operations 
tab in the right panel. If an operation requires user inputs before it can be executed, 
it appears in the Operations tab but not in the Operations menu. A device-specific 
Operations menu pops up if you right-click a device icon in the left panel.

An Advanced Operations submenu is also available. This is where you access the 
Configuration Wizard and other configuration-related commands. To access this 
menu, select Operations -> Advanced Operations.

Group Operations Menu

The Group Operations menu options include Check Consistency, Initialize, and 
Show Progress.
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Log Menu

The Log menu includes options for saving and clearing the message log. 

Help Menu

On the Help menu you can select Help -> Help to view the MegaRAID Storage 
Manager software online help file. You can select Help -> About to view version 
information for the MegaRAID Storage Manager software.

Note: When you use the MegaRAID Storage Manager software online help, you  
may see a warning message that Internet Explorer has restricted the file from 
showing active content. If this warning appears, click on the active content warn-
ing bar and enable the active content.
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Chapter 6

Configuration

You use MegaRAID Storage Manager software to create and modify storage 
configurations. RAID 0, RAID 1, RAID 5, and RAID 10 storage configurations are 
supported.

Important: LSI recommends that you do not use both SAS and SATA drives in 
the same array. Using different drive interfaces in this way could cause unpredict-
able behavior, decreased performance, an increased error count, and decreased 
MTBF.

Note: You cannot create or modify a storage configuration unless you are logged 
on with administrator privileges.

6-1 Creating a New Storage Configuration

You can use the MegaRAID Storage Manager Configuration Wizard to create new 
storage configurations. To open the MegaRAID Storage Manager Configuration 
Wizard, select a controller in the left panel of the MegaRAID Storage Manager 
window and then select Operations -> Advanced Operations -> Configuration -> 
Configuration Wizard.
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Figure 6-1: First Screen Configuration Wizard

The menu lists three configuration modes:

• Auto Configuration automatically creates an optimal configuration from the avail-
able disk drives.

• Manual Configuration gives you the greatest level of control in creating a new 
virtual disk.

• Guided Configuration asks you a few simple questions about what kind of configu-
ration you want and then automatically creates it from the available disk drives.

Note: You can use Auto, Guided, or Manual mode to create a RAID 0, or RAID 
1 configuration. To create a RAID 10 configuration, you must use the Manual 
Configuration mode.
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The following subsections explain how to use the Configuration Wizard to create 
storage configurations:

•  “Understanding Virtual Disk Parameters”

•  “Using Auto Configuration”

•  “Using Guided Configuration”

•  “Using Manual Configuration: RAID 0”

•  “Using Manual Configuration: RAID 1”

•  “Using Manual Configuration: RAID 5”

•  “Using Manual Configuration: RAID 10”

Understanding Virtual Disk Parameters

This section describes the Virtual Disk Parameters that you can set when you 
use the Guided Configuration or Manual Configuration modes of the Configuration 
Wizard. You should change these parameters only if you have a specific reason for 
doing so. It is usually best to leave them at their default settings.

• Stripe Size: A stripe size of 64 Kbytes is supported.

• Disk Cache Policy: Select a cache setting for this disk: Unchanged, Enabled, or 
Disabled.

• Init State:

– No Initialization: The new configuration is not initialized and the existing data on 
the disks is not overwritten.

– Fast Initialization: MegaRAID Storage Manager software quickly writes zeroes to 
the first and last 8 Mbyte regions of the new virtual disk.

– Full Initialization: A complete initialization is done on the new configuration. This 
may take a long time if the disks are large.
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Using Auto Configuration

Auto Configuration is the quickest and simplest way to create a new storage configu-
ration. When you select Auto Configuration mode on the first Configuration Wizard 
screen, the Configuration Wizard creates the best configuration possible using the 
available physical disks.

Figure 7-2: Auto Configuration Screen

Follow these steps to create a new storage configuration in Auto Configuration 
mode:

1. Select a redundancy option from the drop-down menu at the bottom of the Auto 
Configuration window:

– No Redundancy: The new configuration will have no data redundancy (RAID 0). 
If a physical disk in the configuration fails, all data will be lost.

– With Redundancy: The new configuration will have data redundancy via mirrored 
data (RAID 1). If a physical disk fails, data is still protected.
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2. Select an initialization option from the drop-down menu at the bottom of the 
window:

– No Initialization: The new configuration is not initialized, and the existing data on 
the disks is not overwritten.

– Fast Initialization: MegaRAID Storage Manager software quickly writes zeroes to 
the first and last 8 Mbyte regions of the new virtual disk.

– Full Initialization: A complete initialization is done on the new configuration. This 
may take a long time if the disks are large.

3. (Optional) Click Modify if you want to switch to Manual Configuration mode so 
you can modify the suggested Auto Configuration. 

When you click Modify, the Virtual Disk Creation screen appears.  Select the new 
virtual disk, and click Reclaim. Then select the new array from the Arrays with 
Free Space list, and change the virtual disk parameters as needed.

4. Click Finish. The new storage configuration will be created and initialized (unless 
you selected No Initialization).

Using Guided Configuration

Guided Configuration provides an easy way to create a new storage configuration. 
Based on the information that is provided, the Configuration Wizard uses the avail-
able disk drives to create an optimal storage configuration.

Figure 6-3 shows the first screen that appears when you select Guided Configura-
tion.
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Figure 6-3: First Guided Conguration Screen

Follow these steps to create a new storage configuration in Guided Configuration 
mode:

1. Select a redundancy option at the top of the Guided Configuration window:

– Redundancy Only: Create a configuration only if redundancy (RAID 1) is pos-
sible.

– Redundancy when possible: Create a redundant configuration if possible. Other-
wise, create a non-redundant configuration.

– No Redundancy: Create a non-redundant configuration. 

2. Choose whether you want to use existing arrays in the new virtual disk. The 
options are:

– Use Existing Arrays Only

– Don’t Use Existing Arrays

– Use Existing and New Arrays

The first and third options are disabled if there are no available existing arrays.
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3. Select a maximum number of virtual disks to be created. The Configuration 
Wizard may not be able to create as many virtual disks as you want, depending on 
the current configuration and the number of virtual disks that have already been 
created.

4. Click Next to continue to the next window, as shown in Figure 6.4.

Figure 6-4: Second Guided Configuration Screen

5. Change the default volume parameters in this window, if needed. In the top sec-
tion of the window you can specify the number of virtual disks to create. You can 
also choose to use less than the full capacity of this array for the virtual disk(s). 
(You could do this to leave capacity available for other virtual disks that you create 
later.)

6. Click Next to continue to the next window.

7. Check the configuration that you have just defined. If it is acceptable, click Finish. 
If you want to change something, click Back to return to the previous windows.
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Using Manual Configuration: RAID 0

Follow these steps to create a RAID 0 storage configuration using the Manual 
Configuration mode of the Configuration Wizard. 

Figure 6-5 shows the first screen that appears when you select Manual Configura-
tion.

1. In the first Manual Configuration window, select two or more available drives 
in the left panel. Click the Right Arrow button to move the selected drives to the 
right panel.

Note: MegaRAID Storage Manager software will not allow you to select the disk 
drive on which the operating system is installed or any other drives that are already 
part of a configuration.

2. Click Accept to accept these drives for the new RAID 0 array.

Note: To remove a single drive from a proposed new array, select the drive icon 
in the right panel and click the Left Arrow button.

3. Click Next. 

The next Configuration Wizard window appears, as shown in Figure 6-6.

Figure 6-5: Manual Configuration - First Manual Configuration Screen
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Figure 6-6: Manual Configuration - Defining a Virtual Disk

The Arrays with Free Space menu lists the new array that you just defined, plus any 
existing arrays with holes (free space) that could be used for a new configuration.

4. From the Arrays with Free Space menu, select the array to use for the new 
virtual disk.

5. In the right panel, select RAID 0 as the RAID level.

6. (Optional) Set Size (in MB) to a lower number if you do not want to use the entire 
available capacity for the new virtual disk.

7. (Optional) Change the other Virtual Disk Properties, if necessary.

8. Click Accept to accept the configuration of the new virtual disk.

Note: Click the Reclaim button if you want to undo a virtual disk that you just 
defined.

9. Click Next to continue with the next configuration step. The Virtual Disk Sum-
mary window appears.

10. Review the configuration shown in the Virtual Disk Summary window. If you want 
to change something, click Back and change the configuration parameters.

11. Click Finish to accept the configuration and start the initialization process (unless 
you selected No Initialization earlier).
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Using Manual Configuration: RAID 1

Follow these steps to create a RAID 1 storage configuration using the Manual 
Configuration mode of the Configuration Wizard:

1. In the first Manual Configuration window, shown in Figure 6-5, select two avail-
able drives in the left panel. Click the Right Arrow button to move the selected 
drives to the right panel.

Note: MegaRAID Storage Manager software will not allow you to select the disk 
drive on which the operating system is installed or any other drives that are 
already part of a configuration.

2. Click Accept to accept these drives for the new RAID 1 array.

3. To add a hotspare to an array, select an available drive in the left panel. Select 
the array from the drop-down menu, and click Add Hotspare To, as shown in Figure 
6-7.

Figure 6-7: Manual Configuration - Adding a Hotspare
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4. To remove a hotspare from an array, select it in the right panel and click Remove 
HotSpare.

5. Click Next.

The next Configuration Wizard window appears, as shown in Figure 6.6.

The Arrays with Free Space menu lists the new array(s) that you just defined, plus 
any existing arrays with holes (free space) that could be used for a new configura-
tion.

6. Select the array to use for the new virtual disk. 

7. In the right panel, select RAID 1 as the RAID level.

8. (Optional) Set Size (in MB) to a lower number if you do not want to use the entire 
available capacity for the new virtual disk.

9. (Optional) Change the other Virtual Disk Properties, if necessary.

10. Click Accept to accept the configuration of the new virtual disk.

Note: Click the Reclaim button if you want to undo a virtual disk that you just 
defined.

11. Click Next to continue with the next configuration step.

The Virtual Disk Summary window appears.

12. Review the configuration shown in the window. If you want to change something, 
click Back and change the configuration parameters.

13. Click Finish to accept the configuration and start the initialization process (unless 
you selected No Initialization earlier).
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Using Manual Configuration: RAID 5

Follow these steps to create a RAID 5 storage configuration using the Manual Con-
figuration mode of the Configuration Wizard.  Remember that RAID 5 requires:

•  AOC-USAS-L4iR card with the enabled SWR5 jumper enabled

•  activated Super Micro iButton

•  minimum of three hard drives

In the first Manual Configuration window, select three available drives in the left 
panel. Click the Right Arrow button to move the selected drives to the right panel.

Note: MegaRAID Storage Manager software will not allow you to select the disk 
drive on which the operating system is installed or any other drives that are already 
part of a configuration.

2. Click Accept to accept these drives for the new RAID 5 array.

Note: To remove a single drive from a proposed new array, select the drive icon 
in the right panel and click the Left Arrow button.

3. Click Next. 

The next Configuration Wizard window appears, as shown in Figure 6-6.

The Arrays with Free Space menu lists the new array that you just defined, plus any 
existing arrays with holes (free space) that could be used for a new configuration.

4. From the Arrays with Free Space menu, select the array to use for the new 
virtual disk.

5. In the right panel, select RAID 5 as the RAID level.

6. (Optional) Set Size (in MB) to a lower number if you do not want to use the entire 
available capacity for the new virtual disk.

7. (Optional) Change the other Virtual Disk Properties, if necessary.

8. Click Accept to accept the configuration of the new virtual disk.

Note: Click the Reclaim button if you want to undo a virtual disk that you just 
defined.
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Using Manual Configuration: RAID 10

Follow these steps to create a RAID 10 storage configuration using the Manual 
Configuration mode of the Configuration Wizard:

1. In the first Manual Configuration window, shown in Figure 6-5, select two avail-
able drives in the left panel. Click the Right Arrow button to move the selected 
drives to the right panel.

2. Click Accept to accept these drives for a new RAID 1 array.

3. Select two more drives for a second RAID 1 array, and click Accept.

4. To add a hotspare, select an available drive in the left panel. Select the array from 
the drop-down menu, and click Add Hotspare To, as shown in Figure 6-7.

5. To remove a hotspare from an array, select it in the right panel and click Remove 
HotSpare.

6. Click Next.

The next Configuration Wizard window appears, as shown in Figure 6-6.

The Arrays with Free Space menu lists the new arrays that you just defined, plus any 
existing arrays with holes (free space) that could be used for a new configuration.

7. In the left panel, select the two RAID 1 arrays from the menu.

8. In the right panel, select RAID 10 as the RAID level.

9. Click Next to continue with the next configuration step. The Virtual Disk Sum-
mary window appears.

10. Review the configuration shown in the Virtual Disk Summary window. If you want 
to change something, click Back and change the configuration parameters.

11. Click Finish to accept the configuration and start the initialization process (unless 
you selected No Initialization earlier).
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10. Click Accept to accept the configuration of the new virtual disk.

Note: Click the Reclaim button if you want to undo a virtual disk that you just 
defined.

11. Click Next to continue with the next configuration step. The Virtual Disk Sum-
mary window appears. 

12. Review the configuration shown in the window. If you want to change something, 
click Back and change the configuration parameters.

13. Click Finish to accept the configuration and start the initialization process (unless 
you selected No Initialization earlier).

6-2 Adding Hotspare Disks

Hotspares are disk drives that are available to automatically replace failed drives in 
a RAID 1 or RAID 10 virtual disk. Only global hotspares are supported for Embed-
ded MegaRAID Software. 

To add a global hotspare disk, follow these steps:

1. In the left panel of the MegaRAID Storage Manager window, rightclick the icon 
of any unused disk drive.

2. Select Make Global Hotspare.

Make sure the capacity of the hotspare drive is equal to or larger than the capacity 
of the disks in the array and that it is the same type of drive (SAS or SATA).

Note: The hotspare drive will rebuild a failed drive even if it is SAS and the array 
drives are SATA, or vice versa. Once the rebuilt is completed, It is recommended 
that you replace the new array member with a drive of the same type.
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6-3 Changing Adjustable Task Rates

Follow these steps if you need to change the adjustable rates for rebuilds and other 
system tasks that run in the background:

Note: LSI recommends that you leave the adjustable task rates at their default set-
tings to achieve the best system performance. If you raise the task rates above the 
defaults, foreground tasks will run more slowly and it may seem that the system is 
not responding. If you lower the task rates below the defaults, rebuilds and other 
background tasks may run very slowly and may not complete within a reasonable 
time. If you decide to change the values, record the original default value here so 
you can restore them later, if necessary: 

Rebuild Rate: ____________

Background Initialization (BGI) Rate: ____________

Check Consistency Rate: ____________

1. Select the Physical View tab in the left panel of the MegaRAID Storage Manager 
window, and select a controller icon.

2. In the right panel of the MegaRAID Storage Manager window, select the Opera-
tions tab, and select Set Adjustable Task Rates.

The task rates appear in the right panel.

3. Enter changes, as needed, to the task rates for Rebuild Rate, Background 
Initialization (BGI) Rate (for fast initialization), and Check Consistency Rate (for 
consistency checks). Each task rate can be set from 0 to 100. The higher the 
number, the faster the activity will run in the background, possibly impacting 
other system tasks.  

4. Click Go to accept the new task rates.

5. When the warning message appears, click OK to confirm that you want to change 
the task rates.
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6-4 Changing Virtual Disk Properties

You can change a virtual disk’s Read Policy, Write Policy, and other properties at 
any time after the virtual disk is created. To do this, follow these steps:

1. Select a virtual disk icon in the left panel of the MegaRAID Storage Manager 
window.

2. In the right panel, select the Properties tab, and then select Set Virtual Disk 
Properties.

A list of Virtual Disk Properties appears in the right panel.

3. Change the virtual disk properties as needed in the right panel. For information 
on these properties, see Section “Understanding Virtual Disk Parameters"

Note: Only the Disk Write Cache and Read Ahead functions are supported in Em-
bedded MegaRAID Software.

4. Click Go to accept the changes.

6-5 Deleting a Virtual Disk

Caution: Be sure to back up the data on the virtual disk before you delete it. Be 
sure that the operating system is not installed on this virtual disk.

You can delete virtual disks to rearrange the storage space. To delete a virtual disk, 
follow these steps:

1. Back up all user data that is on the virtual disk you intend to delete.

2. In the left panel of the MegaRAID Storage Manager window, select the Logical 
tab, and click the icon of the virtual disk you want to delete.

3. In the right panel, select the Operations tab, and select Delete Virtual Disk.

4. Click Go.

5. When the warning message appears, click Yes to confirm that you  want to 
delete the virtual disk.
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6-6 Saving a Storage Configuration to Disk

You can save an existing controller configuration to a file so you can apply it to 
another controller. To save a configuration file, follow these steps:

1. Select a controller icon in the left panel of the MegaRAID Storage Manager 
window.

2. On the menu bar, select Operations -> Advanced Operations -> Configuration 
-> Save Configuration.

The Save dialog box appears.

3. In the Save dialog box, type a name for the configuration file, or accept the default 
name (hostname.cfg). 

4. Click Save to save the configuration file.

6-7 Clearing a Storage Configuration from a Controller

You can use the Add New Configuration option to add a new storage configuration 
while keeping the existing configuration. Alternatively, you can clear the existing 
storage configuration from a controller and then create a totally new configuration 
or load a previously saved configurationfile.

Caution: Before you clear a configuration, be sure to save any data that you 
want to keep. Clearing a configuration deletes all data from the disks of the 
existing configuration. Be sure that the operating system is not installed on this 
configuration.

To clear a configuration from a controller, follow these steps:

1. Select a controller icon in the left panel of the MegaRAID Storage Manager 
window.

2. On the menu bar, select Operations -> Advanced Operations -> Configuration -> 
Clear Configuration. A Warning message appears.

3. Click Yes to clear the configuration or No to cancel the operation.
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6-8 Adding a Saved Storage Configuration

When you replace a controller, or when you want to duplicate an existing stor-
age configuration on a new controller, you can add a saved configuration to the 
controller.

Caution: When you add a saved configuration to a replacement controller, be 
sure that the number and size of the physical disks connected to the controller 
are exactly the same as when the configuration was saved.

To add a saved configuration, follow these steps:

1. Select a controller icon in the left panel of the MegaRAID Storage Manager 
window.

2. On the menu bar, select Operations -> Advanced Operations -> Configuration -> 
Add Saved Configuration. A Warning message appears.

3. Click Yes.

4. When the Open dialog box appears, select the configuration file, and click 
Open.

5. View the configuration detail, then select Apply.

6. Confirm the new configuration when prompted.


